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What's New in 2004?
New Tools and Technology to
Archive your Family Media!

Ed Rosenthal
Ed will update us on

the latest technological
developments in the com-
puter industry and show us
how to make our research
easier, faster and more
fun making your own DVDs.

Presented by Deanna Spingola
Director of the

Naperville Family History Library

RootsMagic is the easiest to use family tree software avail-
able for Windows XP, 95, 98, ME, NT, and 2000, yet is also one
of the most powerful. It lists for $29.95

If you are looking for a program that is every bit as easy to
use as Family Origins, and every bit as powerful as Family Ori-
gins, and written by the same programming team that wrote
every version of Family Origins, then RootsMagic is the pro-
gram for you.

Deanna will demonstrate the features of the RootsMagic
program.

Creating Word Macros
by

Beverly Levine Smallwood
Page 11

April 17, 2004

A Peek Into Other
Genealogist’s File Rooms

Ann Ellen Barr
How do others keep

and maintain their files?
CAGG-NI members will
share with the group how
they do things.  There are
many ways to organize, no
right way and it’s interest-
ing to see how others do
it.

http://www.rootsweb.com/~ilcaggni
mailto:cagg_ni@yahoo.com
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By Daniel E. Niemiec
I have been running into the follow-

ing situation frequently when working
with Baptism records: The person was
born Vito Domenico Rocco Volpe (mul-
tiple Christian names) and was married
under the name Rocco Volpe (using a dif-
ferent Christian name than the first).  All
the children of Rocco and his wife refer
to his name as Rocco and not Vito
Domenico

Rocco, so when I search the index
for Rocco Volpe, won't find him.  How
do I find this Volpe fellow in my Family
Tree Maker file under EITHER Vito or
Rocco?

See Figure 1.
I want to be able to find him in the

index under either name.  In FTM I click
on the "More About" icon, the little file
cabinet next to "More".

On the right hand side, I click on the
Lineage icon and get this screen.

See Figure 2.
In the field called "This person is also

known as (aka) I enter the name he is
known as during his married life, Rocco
VOLPE.  I can enter the aka name for
anyone who has a slightly different com-
mon name in marriage records than there
is in the baptism records.  (I don't bother
with aka if the first Christian baptism
name is the same as the married
name....only when they differ.)  The trick
is that I have to click on the index icon in
the left corner to bring up my index of
individuals.  On the bottom right of that
window, I click Options and get this
screen.

See Figure 3.
Notice that I clicked "Use aka if

available" AND the box below it "As an
additional entry".  This will place the
"aka" names for everyone in the index in
addition to their official names on their
records.  So I can find Vito Domenico
Rocco Volpe and Rocco Volpe just as
easily and it will bring me to the record
of the man married to Anna Francesca
Serafina Perrino, aka Francesca Perrino.
If I'm looking for the children of Rocco
Volpe and Francesca Perrino, it's not easy

Small Tip for Family Tree Maker Users
when both of them are not listed under
those names.  I only have to change the

index options one time and it will put all
aka names in the index.

Figure 1

Figure 2

Figure 3
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President’s Letter
Some of you know that I attended the GenTech confer-

ence in St. Louis last month.  Lots of exciting topics, vendors
to visit, stuff to buy.  Where were you?  I took in nine lectures
over the course of two days.  It was almost like cramming
nearly a year of CAGGNI into a weekend!  I saw lectures
about how web sites work, putting databases on the web, video
technologies, digital photo albums, building databases,
PowerPoint, self-publishing with MS Word, and DNA test-
ing to solve thorny problems.  For every lecture I attended,
there were four others that I missed.  One of the speakers I
missed will be at the DuPage County Conference on Febru-
ary 28th.  Go to http://www.dcgs.org for details.  It’s al-
ways a good time.

As I mentioned at the January meeting, we will not have
our usual meeting room this month.  Both the TMG group
and the main CAGGNI meetings will be held in the Youth
Services Classroom on the first floor.  The room is smaller
than our usual space.  Deanna Spingola will be presenting a
demonstration of RootsMagic genealogy software.  She will
be doing the same lecture the following week at the Naperville
FHC, so you have two opportunities to see it.

Next month, we will be back in our usual space with Ed
Rosenthal updating us on the latest and greatest in technol-
ogy.  Always a popular topic!

Harve Mankopf, our Program Chairperson, is nailing
down the details for the rest of the year, but let me give you a
small taste of upcoming topics.

Ann Ellen Barr is putting together a panel discussion on
back ups, archiving and filing systems.  If you’d like to par-
ticipate in or contribute to this discussion, please contact us
right away.  You can send an email to me or to the CAGGNI
mailbox and it’ll get forwarded to Ann Ellen.  Everyone has
great ideas on different aspects of this topic, but no one feels
they have all the answers.  Let’s exchange ideas and maybe
we’ll come up with better solutions for everyone.

I’ll be doing a demonstration of uses for Word and Excel
in genealogy later this year.  An article in the electronic sec-
tion of this newsletter is one of the things I’ll be demonstrat-
ing.  Give it a shot.  If it stimulates any new ideas, I’d be
happy to hear them.

Larry Olson will be presenting a session on scanning.
Anne Jacobs will explain GEDCOM to us.  Carolyn Meeker
will be chairing a demonstration of different web sites.  Aaron
Underwood will demonstrate GenSmarts, which I reviewed
in our newsletter last August.  He has since made several
improvements to the program, including direct import from
most major genealogy programs (no GEDCOM required).
Everett Butler will be back in the fall with an interesting topic.
And, finally, I’ll be demonstrating PhotoShop Elements.

Details will be posted to the web site as soon as we get
them.

As always, we’re looking for your contributions to the

newsletter and web site.  Found a great new web site?  An
online database?  Have you a mini-review of a book or video
you have recently read/viewed?  Whether it’s one paragraph
or multiple pages, we’d be happy to get it.  Got an idea for
our web site?  Drop us a line.  No organization can stand
without the support of its membership.

See you soon

mailto:Caggni_Bev@yahoo.com
mailto:waterlooboogaloo@yahoo.com
mailto:G.Conley@Prodigy.net
mailto:j.feitler@ieee.org
mailto:LOlson@mountprospect.com
mailto:DWertz@comcast.net
mailto:mcgovern34@hotmail.com
mailto:Jim@JCottrell.com
mailto:GerryCzadowski@Covad.net
mailto:OKnapp@Juno.com
mailto:clc1040@aol.com
mailto:ucherm@yahoo.com
mailto:Caggni_Bev@yahoo.com
http://www.dcgs.org
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January Program Notes Using Power Point To Tell Your Family’s Story

By Anne Jacobs
Graphics by Gerry Czadowski

At the end of the November meeting,
those who stayed after were given an
added bonus when Carolyn Meeker dem-
onstrated a slide show she had created
for her brother’s 35th wedding anniver-
sary.  At the January meeting, Carolyn
showed how she created the presentation,
encouraging us to take the plunge and
create a presentation with our treasured
pictures.

At this month's CAGG-NI meeting,
Carolyn presented a novel use of
Microsoft PowerPoint program.  Al-
though it has become almost a cliché for
business presentations, Carolyn devel-
oped a memory "album" for presentation
at the wedding of her niece.

Carolyn started by playing the wed-
ding slideshow, to demonstrate what can
be done to create priceless anniversary
and wedding keepsakes.  Carolyn's show
included pictures of events in the life of
bride and of the groom, as well as child-
hood events in common (e.g., scouting,
pets, etc.).  The show was accompanied
by music she had selected, although it was
played by a separate CD player.  (Carolyn
believes that a future version of
PowerPoint will integrate pictures and
music.  Bev Smallwood, President of
CAGG-NI, at the recent convention,
GENTECH, was told that this is possible
but definitely not easy to accomplish.)
The process involved in creating the show
is outlined in the following diagram (see
Figure A).

After whetting our appetite with this
sampling, Carolyn proceeded to show us
just how to build a presentation from the
beginning. Starting with the simplest type
of slide, she created a title page contain-
ing text only.  Showing how to add color
and change the appearance of the text was
easily demonstrated.

 Next, she added a picture to a slide.
Carolyn showed how to create a mat be-
hind the photo by using layers.  Slides
have layers just as Windows operating
system applications can be layered.  You
can add a box with a color fill, which

will appear to frame a picture.  When you
initially add the box, it will appear to
completely cover the picture, then you
move the box backward in the layers, so
the picture is in the front.  As you include
additional items, each layer is added on
top of the previous layer.  The order of
the layers can be changed using one of
the draw/order menus. Next, she showed
how to add text to the frame to “label”
the picture.

Grouping these layers can be helpful
in manipulating items for greater effect.
Selecting several items by dragging a box
around them, you can create a group us-
ing the draw menu and the group
comman.  Now anything done will affect
all layers in that group.  To demonstrate
this, Carolyn rotated the items.  All lay-
ers were rotated the same degrees.  To
ungroup, use the Ungroup command on
the draw menu and the items are sepa-
rated, as before.

Other movement operations are align,
“snap to grid” and nudge.  There is an
invisible grid which the software uses to
align items.  Movements are made in re-
lation to this grid.  You can “snap to grid”
which will move items to align themselves

to the grid’s closest co-ordinates.  Nudge
will move the item(s) a fraction, just as
the name implies, to do this you select an
item and use the arrow keys on the key-
pad to nudge the items up/down or side-
ways.

You can create a slide from several
elements (image, clip art, text box, bor-
der, word art); all were included in her
presentation.  She also demonstrated how
to animate objects and transitioning from
one slide to another.  All these elements
add interest to the “show”.

By adding slides, you create a slide
show.  You can “play” your slide show
manually or automatically, using the slide
transition (Advance after n seconds).
Each slide is displayed in sequence.  Af-
ter a review, you may decide that a dif-
ferent sequence is desired.  You can eas-
ily drag a slide to another location in the
sequence by using the slide sorter on the
view menu. Building the presentation as
she did, showed how simple creating a
presentation can be.

One helpful feature is to add notes
which will accompany the slide but not
be displayed.  This can be used to help
you create a script to accompany your
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January Program Notes (Continued)

presentation or you can use it to identify
the people in the picture in your slide
show.  Only you will see this informa-
tion; it is not displayed on the screen.

There are a number of effects that
can add color to text or backgrounds in a
predefined manner.  Gradient, for in-
stance, will radiate color either from the
center of the slide or from the edges to
the center.  Many other effects are avail-
able; just explore them.  One really use-
ful concept to remember is EDIT/UNDO.
If you do something and don’t like it, se-
lect edit from the command line and click
on undo, to remove the last change you

made.
After discussing the tools available

in PowerPoint, Carolyn identified the
software and hardware she used in creat-
ing the slide show from start to finish.
She used Musicmatch Jukebox ( http://
www.musicmatch.com ) for sound edit-
ing, Roxio EasyCD Creator ( http://
www.roxio.com ) for burning the gift
CD, and Avery™DesignPro™( http://
www.Avery.com ) for designing the CD
labels and jewel box inserts.

Carolyn recommends adding a
PowerPoint viewer to the CD so users
without PowerPoint can still see the pre-

sentation.  The accompanying diagrams
(see Figures B and C) depict the prod-
ucts and equipment that Carolyn used to
create this family treasure.

One danger of making this type of
production - everyone will want a copy.
Carolyn produced multiple copies of the
CD for other relatives.

Not related to PowerPoint, another
software package for display of pictures
is "Flip Album".  Carolyn showed us a
sample of how you can put music and
pictures together for placement on a CD
with an executable version of the pro-
gram.

2004 Membership Dues Deadline

Don’t forget to rejoin CAGG-NI.  Membership runs from
January through December.  This is the last month when
you will be e-mailed or mailed the newsletter without a
renewal.  We would sorely miss you if you did not rejoin!

Now is your chance.

http://www.musicmatch.com
http://www.musicmatch.com
http://www.roxio.com
http://www.roxio.com
http://www.Avery.com
http://www.Avery.com
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Other Group Events compiled by June Buller

22  AND 29 FEB. 2004 – 10.30 A.M.
Temple Judea Mizpah

8610 Niles Center Rd., Skokie
Mike Karsen

Discovering Your Jewish Roots
Course No. C202W04

$10 members; $20 non-members
e-mail: info@dawnschuman.org or call

847-509-8282 for further information

22 FEB 2004
Temple Judea Mizpah

8610 Niles Center Rd., Skokie
Introduction to Jewish Genealogy

Course No. C202AW04
$7.50 members; $12 non-members

e-mail: info@dawnschuman.org or call
847-509-8282 for further information

28 FEB. 2004 – ST. CHARLES

29th Annual Conference
SPEAKERS: PATRICIA REAVES, PAUL MILNER AND JOHN

KONVALINKA

DuPage County Genealogy Society
http://www.dcgs.org

29 FEB. 2004
Temple Judea Mizpah

8610 Niles Center Rd., Skokie
Resources for Jewish Genealogy

Course No. C202BW04
$7.50 members; $12 non-members

e-mail: info@dawnschuman.org or call
847-509-8282 for further information

1 MAR 2004
LINDA HERRICK

What Can You Find Between the Covers
of German Books?

German Interest Group – Wisconsin
http://www.rootsweb.com/~wigig/

6 MAR. 2004 – CHICAGO – 1:30 P.M.
Rosalie Lindberg – Polish Genealogy

Chicago Genealogical Society
http://www.chgogs.org/

15 MAR 2004 – ZION

NANCY SALMELA AND OTHER MEMBERS

Preparing for a Research Trip
Zion Genealogical Society

http://wkkhome.northstarnet.org/zion/
zgsmeeting.html

17 MAR. 2004 – WHEATON – 7 P.M.
BROTHER JOSEPH MARTIN

Researching Your Immigrant Ancestors
DuPage County Genealogical Society

http://www.dcgs.org/

18 MAR. 2004 – ARLINGTON HEIGHTS – 7:30 P.M.
SANDRA  HARGREAVES LUEBKING

Researching Females
Northwest Suburban Council of Genealogists

http://www.mtprospect.org/nsgs/

20 MAR. 2004
CAROL KNIGGE

Searching for Your Ancestors
in Church Records.

Clues on Using Parish Records of the British Isles
BIGWILL

http://www.rootsweb.com/~wiilbig/

20 MAR 2004 – ZION – 1:00 P.M.
TERRY BUNSEN

Creative Memories Workshop
Zion Genealogical Society

http://wkkhome.northstarnet.org/zion/
zgsmeeting.html

20 MAR 2004 – FORT WAYNE, IN
MICHAEL JOHN NEILL

Finding Your Forebears in the 21st Century
For more info: mailto:kaufmansusan@uno.com

Or write ACGSI, POBox 12003, Fort Wayne, IN
46862

25 MAR. 2004 – WHEATON

WAYNE WEBER

Finding Your Roots in the Billy Graham
Center Archives

Kane County Genealogical Society
http://www.rootsweb.com/~ilkcgs/

26-27 MAR. 2004 – PROVO, UTAH

BYU Seventh Annual
Computerized Genealogy Conference

http.//genealogyconferences.byu.edu

27 MAR 2004 – SOUTH BEND, IN
Michiana Area Genealogy Fair

South Bend Area Genealogical Society
http://www.rootsweb.com/~insbags/genfair.htm

mailto:info@dawnschuman.org
mailto:info@dawnschuman.org
http://www.dcgs.org/
mailto:info@dawnschuman.org
http://www.rootsweb.com/~wigig/
http://www.chgogs.org/
http://wkkhome.northstarnet.org/zion/zgsmeeting.html
http://wkkhome.northstarnet.org/zion/zgsmeeting.html
http://www.dcgs.org/
http://www.mtprospect.org/nsgs/
http://www.rootsweb.com/~wiilbig/
http://wkkhome.northstarnet.org/zion/zgsmeeting.html
http://wkkhome.northstarnet.org/zion/zgsmeeting.html
mailto:kaufmansusan@uno.com
http://www.rootsweb.com/~ilkcgs/
http.//www.genealogyconferences.byu.edu
http://www.rootsweb.com/~insbags/genfair.htm
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Other Group Events
3 APR. 2004 – ST. LOUIS, MO
Annual Genealogical Fair

John Colletta, Speaker
http://www.stlgs.org

16-19 APR 2004 – SALT LAKE CITY, UTAH

United Polish Genealogical Societies Conference
Continuing the Challenge

http://www.pgscs.org

http://www.polishroots.org

23-24 APR. 2004 – OCONOMOWOC

Gene-A-Rama 2004
Featured Speaker – John Philip Colletta
Wisconsin State Genealogical Society

http://www.rootsweb.com/~wsgs

19-22 MAY 2004 – SACRAMENTO

NGS Annual Conference and Genealogy
Exhibit

http://www.ngsgenealogy.org/

6 JUNE 2004 – SKOKIE

Full Day Workshop
L’Dor V’Dor / From One Generation to the

Next
Jewish Genealogical Society

mailto:jgsi2004@yahoo.com for further information

Cyndi Howells of http://www.cyndislist.com

will be speaking at the Glenview Public Library on
Saturday, March 27th from 10 a.m. to 4 p.m.
Registration will start on March 1st for Glenview
residents and March 16th for non-residents.  The
cost is $8-10 includes lunch and you must register
in person at the Information Desk in the library.

The topics will be:

The World Wide Web - Quit Surfing and
Start Researching;

10 Commandments of Internet Genealogy
A Guided Tour of Cyndi's List
Question and Answer Session

For library location and details, see the Day
Tripper’s Guide To Local Library Resources on the

CAGGNI web site.  Contact: Deena Butta,
mailto:butta@CLSN3046.glenview.lib.il.us

847-729-7500 x152 with any additional questions.

Chicagoland Family History Centers
Buffalo Grove FHC News (Cook, Lake Counties)

15 East Port Clinton Road
(Corner of Prairie & Port Clinton Roads)

1-847-913-5387
Hours: Wed., Thurs.

10:00am-2:00pm and 7:00pm-9:30pm
Sat. 10:00am-2:00pm

Closed Sunday, Monday, Tuesday and Friday
The Buffalo Grove Family History Center now has some ex-

citing new tools to assist our patrons with their genealogy.  This
includes a Canon imaging scanning microfilm reader/printer and
free high speed access to the Internet.  In addition to all Church
sites, we also have free access to Ancestry.com. and many more
sites.

All are invited to attend the monthly training meetings held
on the 3rd Tuesday of the month. For additional information and
to signup, contact the Family History Center.

Blood Washes Blood:
A True Story of Love, Murder and Redemption
Under the Sicilian Sun

Frank Viviano, Washington Square Press, 2001,
270 pages

Reviewed by Larry Olson
This book was highly recommended by a co-worker, Tom

Bushery (who spoke at CAGG-NI several years ago).  Truthfully,
the copy he loaned me sat on my desktop literally for months.  I
don’t have Italian ancestors (but neither does he) and frankly, my
knowledge of/interest in anything Sicilian was previously limited
to “the Godfather, Part I.”

Once I began the book, however, I was very pleasantly sur-
prised, and found it hard to put down.  Frank Viviano, a foreign
correspondent for the San Francisco Chronicle, is struggling to
solve the late nineteenth-century murder of his great-great-grand-
father, a possible highwayman known as ‘the Monk.”  Frank’s
mission began as a result of some end-of-life remarks made by his
grandfather (the namesake of the Monk, whose name Frank also
shares).

Frank settles in Terrasini, Sicily, the village of his ancestors,
between assignments in Bosnia and Iraq.  His experiences there
provide excellent lessons in doing research “at the source” in a
foreign land.  He encounters stonewalling by civil servants, li-
brarians, and church officials, and attempts to gain the confidence
of suspicious locals who supposedly know stories of the old days.

Frank learned that interwoven with his grandmother’s fables
were actual events in Sicilian history, including the battle for in-
dependence under Garibaldi, and the rise of the Mafia.  (Fortu-
nately, pedigree charts, plus maps of Sicily and the province of
Palermo are included, which helped me to keep the names and
places straight.)

Part history, travelogue, autobiography, mystery story, and
genealogy, I found it to be a very enjoyable as well as informative
read.

http://www.stlgs.org
http://www.pgscs.org
http://www.polishroots.org
http://www.rootsweb.com/~wsgs
http://www.ngsgenealogy.org/
mailto:jgsi2004@yahoo.com
http://www.cyndislist.com
mailto:butta@CLSN3046.glenview.lib.il.us
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Moving Data From Web Tables Into an Excel Spreadsheet
 by Beverly Levine Smallwood

Have you ever gone on a fishing ex-
pedition, gathering everything on a par-
ticular surname?  Web sites like Ances-
try and RootsWeb present search results
in tables.  I’d like to get the results onto
my computer in an Excel spreadsheet so
that I can sort it in more meaningful or-
der.  I can type them in if there are just a
couple of hits, but what if there are 20 or
50 or hundreds?  The more hits you get,
the more you need the power of Excel to
sift and sort them, but I don’t want to
type in hundreds of entries.

Excel needs data in a uniform for-
mat in order to successfully import.  It
likes each row to end with a paragraph
mark and each column to be separated
by a delimiter.  The best delimiter is a tab
since commas can be contained within a
column’s data.  Thus, any collection of
data formatted in this fashion can be eas-
ily imported into Excel.  Unfortunately,
html tables don’t fit this description.

I did a search in the SSDI on
RootsWeb for this example.  If I selected
the table and copied it to the Windows
clipboard (CTRL+C), then pasted it
(CTRL+V) into an empty spreadsheet,
Excel may or may not put the data into
the appropriate rows and columns.

In my SSDI example, Excel put it
into rows and columns, but each line from
the Results Table actually created four
rows in Excel.  Whenever a cell in the
html table contained multiple lines, Ex-
cel put each line in a separate row.  You
can go through and clean them up manu-
ally, but if you are copying and pasting a
lot of records, that could take a great deal
of time.  I’m going to use the power of
my computer to speed up the process.

I often use Word to reformat data for
Excel.  However, opening a blank docu-
ment and pasting the same table just gives
me a blob of data.  Reformatting this
manually would be an even bigger night-
mare than fixing it in Excel.  Time to
approach the problem from another di-
rection.  The results table displayed in
html wasn’t giving me what I needed, so
I decided to examine the raw html for

consistant patterns I could manipulate.
Back in the browser, just above the

results table is the phrase “results 1 thru
10 of 16” which is marked with a red ar-
row in Figure 1.  Highlight that and copy
it.  Now we’re going to look at the source
of the web page.  In Internet Explorer,
select Source from the View Menu.  [In
Netscape, select Page Source from the
View Menu.]  This opens up a file in
Notepad containing all the data and the
html tags.  Don’t panic.  You don’t have
to understand all the html stuff.  In
Notepad, press CTRL+F to open the Find
dialog box, which can also be accessed
via the Edit Menu.  In the box next to
“Find what” paste the phrase you copied
from the clipboard and press enter [Fig-
ure 2].  This drops you down to the phrase
that you know appears immediately be-
fore the table.

Html defines each table beginning
with <TABLE> and ends each table with
</TABLE>.  These tags may or may not

be in all caps.  Look for the beginning of
the table.  In this case, the beginning is
marked with some additional formatting.
I’ve marked the beginning and ending of
the Results Table with red arrows in Fig-
ure 3.  Select everything on the lines be-
tween the <table> and the </table> and
copy it to the clipboard.  Now open a
word document and paste it.

Remember that Excel likes rows to
end with a paragraph mark and column
data to be separated.  Html starts each
table row with <tr> and ends it with </
tr>.  Each table column within the row
starts with <td> and ends with </td>.  We
are going to use Word’s Search & Re-
place function to put a tab between each
column and a paragraph mark at the end.

Open the Replace function either
from the Edit Menu or by pressing
CTRL+H.  Type </tr> into the “Find

what” box and tab to the “Re-
place with” box.  Now click on
the “Special” button, select
“Paragraph Mark”, and then
click on “Replace All”. [Figure
4]  If the Special button doesn’t
show, click on the “More” but-

ton on the right side. In this case, each </
tr> was already followed by a paragraph
mark.  We can remove the extras by

Figure 2

Figure 1
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Excel (Continued from page 8)

“Finding” two paragraph marks and re-
placing them with a single paragraph
mark.  To separate the columns with a
tab character, “Find” </td> and replace
it with Special ➤  Tab Character.

Now we need to get rid of the extra
junk.  Do individual Searches for <td>,
<tr>, and any formatting stuff like <br>
making sure that the “Replace with” box
is empty.  Now Word will remove them
since they are being replaced with noth-
ing.  In this example, the column headers
were separated by <th align=left> or <th>
and </th>.  We want to remove <th
align=left> and <th> and replace </th>
with a tab character.  If your table con-
tains additional formatting items like
<bold>, <b>, <font …>, etc., you will
need to remove them as well.  The goal is
to remove all the special html formatting
and end up with pure search results data
in a format that Excel will import.

Once you’ve finished cleaning up the
data, select all (CTRL+A), copy it, and
go to Excel to paste it.  You can resize
your columns now to see the pasted data.
It’s better, but there are still some prob-
lems we can fix.

If you look at the date columns, you’ll
see some of the dates were imported just
the way they appeared on the web page
(25 Jul 1884) and others were converted
by Excel into a date (12-JAN-14).  That

is because Excel doesn’t recognized dates
prior to 1900 and is treating it as text.  In
order for this to
sort properly we
need to reformat
the dates ourselves
into something Ex-
cel can consistently
understand.

First, go to a
blank worksheet in
Excel.  Select the
entire worksheet by
clicking on the box
in the upper left-
hand corner to the
left of "A" and
above "1".  With the entire worksheet
highlighted, right click anywhere on it and
select “Format Cells”.  On the Number
Tab, select Text.  This will force Excel to
accept all entries as is, rather than trying
to convert or interpret.

Now click in cell A1 and paste your
stuff from Word into this blank
worksheet.  The date column should now
contain text that looks just like the web
page.  We’ll come back to this in a sec-
ond.

Go get the rest of the data from the
web results pages by clicking on "Next",
opening the source, and repeating the pro-
cess of reformatting in Word, and past-

ing to the first blank row and cell in Ex-
cel.  Do this for each results page.  To
really speed things up, we can create a
macro in Word so that all reformatting
will be done with a single click.  I’ll cover
Macros in a separate article.

Now that your spreadsheet is popu-
lated with data, let’s clean it up a bit more.
The last two columns of the SSDI table
contain hot links to various web functions
to write letters or add “post its”, etc.  We
don’t need them, so select the columns
by clicking on the “H” and dragging the
mouse to “I” before releasing it [Figure
5].  Now select “Delete” from the Edit
Menu.  Pressing the delete key will only
empty the columns, not remove them.
Since they are the end columns, empty-
ing is the same as deleting but it makes a
difference if you want to remove a col-
umn between two others.

Now let’s
look at some of
the other prob-
lems with the
data.  When
we sort dates,
we first order
them by year,
then month,
and then day.
The dates in this table are day-month-
year.  Sorting in this fashion will put the
20 Dec 1890 before 25 Jan 1875.  In or-
der for Excel to sort text as though it were
dates, it must be in Year-Month-Day or-
der.

Figure 3

Figure 4
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To reformat the birth dates, select the
column by clicking on the “B” above it,
copy it, then paste it in a blank Word
document.  This creates a single column
table in Word, but we need it to be text.
Click anywhere in the table and choose
“Select Table” from the Table Menu.
Now that the table is selected, choose
“Convert Table to Text” from the Table
Menu and click “OK”.  Making sure that
your cursor is at the beginning
(CTRL+Home) and Replace each space
(just press the space bar once) with Spe-
cial ➤  Tab Character.  Select All and
copy.  Go back to Excel, move to the first
empty column in row 1, and paste.  Since
we earlier selected the entire worksheet
and told it to treat everything as text, we
will not lose the leading zeros on dates
between the 1st and 9th of the month.

We now have the Day, Month, and
Year in three different columns, but still
in the wrong order.  Select the Day col-
umn and cut it (CTRL+X), arrow to the
right of the Year column and press enter.
Now select the Year column, cut it, ar-
row to the left of the Month column (the
blank space left by the day column), and
press enter.  Select the empty column be-
tween Month and Day and delete it using
Edit Menu ➤  Delete.

Now that the columns are in the cor-
rect order, select the Year, Month, and
Day columns, copy, go to Word, and
paste.  Select the table as described pre-
viously and convert it to text, making sure
that Tabs is selected under “Separate Text
with”.  If there are extra Tabs in front of
the header “Births”, remove them now.
Replace Tabs with a dash “-”.  Lastly,
we need to replace the month text with

numbers, making sure to use the
leading zeros for January
through September.  Replace
“Jan” with “01”, etc.  Since this
is something you might need to
do often, it should be recorded
as a macro (see next article).
When you’ve finished, the dates
should look like “1903-01-23”.
Select all, go to Excel, select the
Birth column, and paste.  Re-

peat these steps to reformat the Death
column.  The only hitch here is that you
will need to put a tab in front of any
Month for which there is no day of death
to hold the Day column open [Figure 6].
You may chose whether to keep the (V)
or (P) after the date, together with the
date, in a separate column or not at all.

The next problem we need to deal
with is the Last Benefit & Last Residence
columns.  RootsWeb has helpfully in-
serted hypertext links to each county’s re-
spective web page [Figure 7]. Select the
Last Residence column, copy, then paste
it into Word.  Select the table and con-
vert it into text.  There are two bits we

need to remove.  The </a> can be removed
with a simple Replace with nothing.  The
other part is variable depending on the
county, but looks something like this: <a
href="http://resources.rootsweb.com/
USA/FL/Pasco">.  You’ll note that it is

set off with “<>” symbols.  We can re-
place these symbols with tabs, copy ev-
erything into a spreadsheet, delete the
column, then copy the two remaining col-
umns back to Word.  After converting the
table to text, simply Replace the Tabs
with nothing to rejoin the two parts of
the field.  Then select all and paste it back
to its original location in Excel.  Repeat
the process with the Last Benefit column.

Your finished spreadsheet will look
something like Figure 8.  You may now
sort on any column or combination of
columns.  You can add columns that
would have meaning to you, like cross-
referencing the ID numbers from your ge-
nealogy program.  Obviously, there are a
lot of steps involved in reformatting,
much of which can be automated using
Macros.  Once the Macros are in place,
you can quickly gather hundreds of
records from web searches into Excel.

I will be demonstrating this process
and some others at a CAGGNI meeting
later this year.  If you aren’t an expert by
then, bring this newsletter so you can fol-
low along.

Figure 5

Figure 6

Excel (Continued from page 9)

Figure 8

Figure 7

http://resources.rootsweb.com/USA/FL/Pasco
http://resources.rootsweb.com/USA/FL/Pasco
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by Beverly Levine Smallwood
Macros are a good way to automate

repetitive tasks.  To quote the Word help
file: “A macro is a series of Word com-
mands and instructions that you group
together as a single command to accom-
plish a task automatically.”  In “Moving
Data from Web Tables into an Excel
Spreadsheet” I gave many steps to edit
data that you would have to repeat for
each web table that you were going to
import.  A macro would be a way to get
those steps down to a single mouse click.

Macros are actually quite easy to
create.  Simply choose Macro à Record
New Macro… from the Tools Menu.
Give your Macro a name and choose
whether you want a toolbar macro or a
keyboard macro.  My preference is
toolbar, because I have trouble remem-
bering what combination of keys I pick.

I am going to create a Macro to re-
place all month names with numbers as I
did to reformat dates for Excel in the other
article, so I’ll call it Months and click on
Toolbars.  Once I click "Close" a small
box comes up with a square and a circle
preceded by two vertical lines [figure 1].

This is the Stop and
Pause record.  From the
time you close the dia-
log until the time you
click on the square to

stop it, the Macro Recorder is keeping
track of all your actions.  You’ll also note
that your cursor now has a cassette tape
attached to it to indicate that you are re-
cording a macro.

I like to start all macros by position-
ing my cursor at the top with a
CTRL+Home.  Now do all your Replace
entries to change “Jan” to “01”, “Feb” to
“02”, etc. and click on the stop record
button when you’ve finished.  The
Months macro is now recorded and can
be played by going to Tools à Macro à
Macros … or with ALT+F8, then click-
ing on “Months” and then on Run.  To
make that more convenient, let’s add it to
our toolbar.

Right click on an empty area on the
toolbar and select Customize…  Click on

Creating Word Macros
the Commands tab, and select Macros in
the Categories box.  Locate “Months” to
the right, click on it and drag it to the
toolbar.  Once in place, select Modify
Selection.  From here you can choose
whether your toolbar button will be text,
an image (Default Style), or both an im-
age and text.  I prefer just an image so
I’ll click on Default Style. [Figure 2]
Clicking on Change Button Image will
bring up a small set of button images you
may use.  You may also copy buttons
from other programs or design your own
16x16 pixel buttons.

Now clicking on a button will change

all your months from three letters into two
numbers.  Suppose, however, that the
month is spelled out as January rather
than “Jan”.  You could record another
macro, but I would simply edit the exist-
ing one.  Try fiddling around with the
Visual Basic.  I don’t think you’ll find it
that difficult to copy and edit.

Your next macro project is all the
search and replace entries needed to re-
format the html table source into some-
thing that Excel can import easily as de-
scribed in my other article.  Once you
begin playing with macros, you’ll see all
kinds of tasks you could automate.

Figure 2
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